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Navigating WS 
Navigating through WS can be done using the Navigation Button located in the top left corner of the main window. 

Clicking on this button will show a navigation menu with multiple Navigation Items. 

1. Click the Navigation Button 

2. Locate desired section and click 

When clicking on a navigation item, the view for that item will normally 

appear as a tab. The tabs make it easy to navigate back and forth be-

tween modules. If a tab is already open, clicking on the respective item in 

the Navigation Menu will cause the existing tab to appear. 

 

 

 

 

 

 

Ribbon in WS 

The Ribbon is located at the top of the WS Software. The Ribbon contains the commands 

and tools that you need to work in WS.  
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Home  

The Home Ribbon varies slightly depending on which tab you have open.  

NEW: New is used to create new Clients, Hotline Calls, Incidents, etc. The drop down for New will 

change depending on what window you have open. 

 

SAVE: Save has three options, Save, Save and Close, and Save and New. All options save 

your current work.  Save, saves your work and keeps the current window open. Save and 

close will save your work and then close the current window. Save and New will save your 

current work, close the current record and then create a new record.  

   

Edit: In the Edit section you will find three options, Delete, Cancel, and Validate. Delete will 

erase the record from the application. Cancel will remove any changes you made in the fields 

(cancel will not work when you delete records by mistake).  Validate is used to ensure all infor-

mation is entered, and no rules are broken before attempting to save your work.  

 

Open Related Record: Open Item is used to open a drop down value. Once open, you can then edit the drop down. 

View: View has three options, Shelter Stats, Refresh, and Show Report.  Shelter Stats 

shows stats related to your shelter data, such as current stays. Refresh is used to refresh 

changes in an open tab when you make and save changes in another tab. (For Example 

you add an incident to a Client and Save the changes, if you have the Incident List open, 

you must click Refresh on the tab for the incident to show up in the list).  Show Report 

allows you to quickly run a report related to the open or highlighted record.  

 

Close.  Close will close the current tab that is open, if information in unsaved, WS will ask the user if they 

would like to Save, in most cases Yes is desired. 

 

Records Navigation. It is used to move up or down in the list of Objects.  (For example a Client 

is open; clicking Next will show the Next Client in the List of Clients) 

 

Filters and Full Text Search: These areas are discussed in greater details in the section Filtering in a List View 
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View 

The View tab is used to change the display of the software. Please see explanations below. 

Changing the Theme of the Software 
1. Select a Theme from the various options 

listed under appearance  

 

 

Window List 
Window List is used to navigate through the software. A 

list of open windows can be seen at the bottom of the 

list. Select a window to navigate to it. 

 

Window list allows you to create new vertical and hori-

zontal tabs, as well as float current tabs. 

 

 

 

Navigation Panel 

 
Use Panels to set the Navigation panel as Visible, Hidden or Auto 

hide. If you make the Navigation Panel visible it will appear on the 

left side of your screen. It allows you to easily navigate through the 

database.  
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Tools 

Send and Show Log File 
Send Log File 

Send log File is used to send your log file to Osnium’s technical support team. If an error occurs, it is used to diagnose 

what occurred in the system before the error occurred.  

 

1. Click Send Log File 

2. Select Yes 

 

3. Include as much detail as possible regarding the steps leading up to the error. 

 

4. Finally, use the dropdown to select the priority level 

of the issue.  For example: 

a. Low  – happened once, did not impact the 

functionality of WS 

b. Medium – occurs infrequently, and can con-

tinue to work around the error 

c. High – frequently occurs, causes loss of work 

or impairs ability of WS to function  

d. Critical – cannot continue to 

use WS 

Show Log File 

Show Log File load a window that shows you 

what has occurred in the system. 

 

1. Click Show Log File 

2. A new window will appear with the 

log file 
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Save Customization Summary 
Save Customization Summary creates a document outlining all 

customizations for the database.  

1. Click Save Customization Summary 

2. Select a location to save the file, enter a File name and 

click Save 

 

Note: It may take a few minutes for the file to save. 

 

Perform Full Backup 
The Perform Full Backup button is a quick way to backup your database.  

Creating a New Backup 

1. Click Perform Full Backup, select Local > New 

 

2. Name the backup file (For Example: WS_Backup_Database) 

3. Choose a location for the backup (For example: C:\Backups) 

Performing the Backup 

1. Click Perform Full Backup, select Local, and click the desired 

backup 

 

2. Click OK 

 

3. WS will notify you when the backup is complete. The backup 

file can now be found in the desired location. 

 

Edit/Delete Backup Location 

1. Click Perform Full Backup, select Edit 
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2. The window below will open 

 

 

 

 

 

 

 

 

 

 

 

3. Double Click on a Backup to edit the name or location of the 

backup 

 

 

 

 

 

 

4. The Delete and New button can be used to Delete Existing backups or Create New backups. 
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Import/Export Data 
The Import/Export Data button is used by Osnium Staff to import data into your database. It is not generally used by Clients.  

Show Audit Trail 
Show Audit Trail is visible on detail views and shows changes made to the open record. It shows the User Name that made the 

change, the date, the operation type and a description of the change. 

Show Business Object Info  
This is used by Osnium Staff members to determine what fields were originally named. This is not generally used by Clients.  

Osnium Connect 
Osnium Connect will link you to the webpage connect.osnium.com. Osnium Connect is used to connect remotely with Osnium’s 

staff when you require technical assistance. 
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People 
People/Clients include any Adult, Child or Alleged Abuser in the database. 

List Views 

People List View 
People List view shows you a list of all Adults, Children/Dependents and Alleged  

Abusers 

To open the person list view 

1. Click the Navigation Button and click on People from the drop down. A list of 

all persons in the system will open.  

 

2. The person list view can be seen below. A full list of persons can be seen on 

the left side of the screen. The right side of the screen shows a preview of the 

selected participant. 

 

Creating New Clients, Children and Alleged Abusers 

Creating a Client/Child/Abuser from a List View 
There are two options for creating a new person from a list view 

Option 1: 

1. Click New from the Dashboard Ribbon 

2. Select Client, Child or Alleged Abuser as desired. 
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Option 2: 

1. Right click on the list on the left 

half of the screen 

 

2. Hover over New and select Cli-

ent, Child or Alleged Abuser as 

desired 

 

 

 

Creating a Client/Child/Abuser/Hotline Call from a person detail view 
There are two options for creating a new person from a client/child/

abuser detail view. 

Option 1: 

1. From a client/child/abuser/hotline call detail view select Save 

and New from the Ribbon 

 

2. Select Client, Child or Alleged Abuser as desired 

Option 2: 

1. From a client/child/abuse/hotline call detail view select New from the Ribbon 

 

2. Select Client, Child or Alleged Abuser as desired 
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Client/Adult Detail View 

Double click on a Client from the list to see a detail view.  

Opening a Client from the Client list will result in the details below: 

The Client Detail View contains information regarding the client. Most fields are drop downs, or text boxes. 

Please note instructions for the following fields: 

 Estimated Age 

o If you enter the Client’s estimated age, the date of birth estimated checkbox will be automatically se-

lected. 

 Phone Numbers 

o Select … to open the phone number fields 

o The selected Primary number will appear on the client profile 

 Address 

o Select … to open the address fields 

o Inputting the zip code will auto-populate the city, province and country 
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Tabs within a Client Detail View 
Clients have a variety of historical information and associated records included in tabs at the bottom of their Client record. These 

tabs include: 

 

 General/Employment/Income Information 

 Children/Dependents  

 Alleged Abuser 

 Victimizations 

 Services 

 Programs/Stays  

 Referrals 

 Financial Assistant Provided  

 Protection Order  

 Clinical Notes 

 Related Calls  

 Surveys  

 File Attachments  

 

General/Employment/Income Information Tab 

General/Employment/Income Information contains additional relevant information for the Client. 

 Employment/Income 

 Special Classifications 

o Click Add to select a classification  

o Select all that apply (hold Ctrl to select multiple options) 
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Children/Dependents 

The Children/Dependents tab contains a list of all children/dependents associated with the client. 

Linking the Children/Dependents 

 There are two options to link Children to a Client 

o 1. Click Add and select one or multiple preexisting Children from the list 

o 2. Create a New Child, add the child details to the profile, then Save and Close 

 To remove a Child/Dependent from the list 

o Select the Child from the list and click Remove 

Viewing the Children/Dependents 

 Double click on the Child to open a detail view. 

 The parent will be automatically populated into the Child’s profile 

 

 

Note: This linkage works both ways. You can add a Parent to the Child’s profile by selecting a client from the drop down list and the 

Child will populate onto the Parent’s profile.  
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Alleged Abuser Link 

Creating a New Alleged Abuser  

1. Select New in the Alleged Abuser Link tab 

2. Fill in the details related to the abuser  

 

Victimizations Link 

Creating a New Victimization for more detailed information see Victimizations – Create a New Victimization  

3. Select New in the Victimizations Link tab 

 

4. Fill in the details related to the victimi-

zation 

 

5. Select the Victim Type and Victimization Type. If known, the Primary Abuser from a list of Abusers in the data-

base, OR create a New Abuser 

6. Save and Close 

Other Victimization Types  

1. Choose another Victimization from the list 

by clicking the Add button  

 

Note: hold CTRL down to add more than one  
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Services 

The Services section contains a list of services related to the Client. Double click on a service to view a detailed view of 

the record. For more detailed information please see Service - Creating a New Service Record  

To create New Service 

1. Click the New button in 

the upper left hand cor-

ner of the Services Tab  

 

 

2. Fill in details add Topics by clicking Add un-

der the Topics tab hold CTRL to add more 

than one 

 

 

 

 

Program/Stays 

The Programs/Stays section contains a list of stays related to the Client. Double click on a stay to view a detailed view 

of the record. For more detailed information as well as information relating to HUD please see Shelter Stays - Creating 

a New Stay Record   

To create New Stay  

1. Click the New button in the upper left hand corner of the Shelter section in the Program/Stays Tab  

 

 

2. Select the type of stay, from 

here you can also add children 

if they stay with the parent  
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Program/Location contains a list of program enrollments for the Client. 

1. In the Type drop down select Outreach / Non-Residential  

 

2. In the Program / Location dropdown select the program 

 

Referrals 

Referrals contains a list of services you have referred the client to. Dou-

ble click a referral to see a detailed view of the record. 

To create a new Referral  

1. Click New in the upper left hand corner of the 

Referrals tab 

 

2. In the pop up select the Destination of the referral  

 

3. Any notes associated with the referral 

4. Save and Close 

 

 

Financial Assistance Provided Tab 

Contains a list of all Financial Assistance that has been provided to this client. Double click the an assistance note to 

see a detailed view of the record. 

Creating a new Financial Assistance  

1. Click the New button in the top left hand corner of the 

Financial Assistant Provided tab.  

2. Complete the pop up select a Financial Assistance Type 

from the dropdown list 

3. Save and Close  
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Protection Order  

The Protection Order tab contains a list of protection orders associated with the client. Double click an order to see a 

detailed view of the record. 

Creating a New Protection Order 

1. Click New in the upper left hand corner of the 

Protection Order tab  

 

2. Fill in the details for the protection order 

 

3. Save and Close 

 

Clinical Notes 

The Clinical Notes tab contains a list of notes associat-

ed with a client. Double click on a note to see a de-

tailed view of the record. 

To create a new Clinical Note 

1. Click New in the upper left hand corner of the Clinical 

Note Tab 

 

2. Enter the Date, Subject and Notes associated  

 

3. Save and Close  

Related Calls Tab 

Contains a list of all Calls associated with the Client including hotline calls. Double click on a call to see the detailed 

view.  
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1. New is used to create a Hotline or Related Call for the selected Client, click the New button in the top left hand 

corner of the Related Calls Tab. It will automatically fill in the Client’s First Name and Last Name in the new call. 

Fill out the remainder of the information. 

2. Add in the Call Type, Hotline or Information / Referral and any other relevant information  

3. Save and Close 

Surveys 

The Surveys Tab contains a list of surveys completed by the Client. Double Click on a Survey to see a detailed view. 

To create a New Survey 

1. Click New in the 

upper left hand cor-

ner of the Surveys 

Tab 

2. Select they type of survey by double clicking it 

3. Complete the Survey 

 

4. Save and Close 
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File Attachments Tab 

Contains a list of all File Attachments associated with the Client. The File Attachments are embedded into the software. 

To add a New File Attachment: 

1. Click on the New button in the upper left hand corner on the File attachments tab. 

 

 

 

2. Click the “dot dot dot” 

 

 

 

3. This will open a dialog box that will 

allow the user to locate the file, click Open to add to the File Attachment 

record: 

  

4. Save and Close the attachment window 

Child Detail View 

Opening a Child profile will result in the screen below. 

The Child Detail View contains information regarding the child. The data collected is very similar to a Client.  

Please note instructions for the following fields: 
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Parent/Guardian Information: 

- Click the drop down, and select an existing Client profile OR create a New Client profile to link a Client to the 

Child. 

 

 

 

 

 

Alleged Abuser Detail View 

Opening an Alleged Abuser Profile will result in the screen below. 

The Abuser profile contains significantly less information than a Client or Child profile. Most fields are drop downs, text 

boxes or check boxes. 

Please note instructions for the following fields: 

Photo: 

 To upload a new photo: Double click on No image data to add an image 

 To change an existing photo: Right click on an existing photo and select  load 

 To delete an existing photo: Right click on the existing photo and select delete 

File Attachments 

To add a New File Attachment: 

1. Click on the New button in the upper left hand corner on the File attachments tab. 
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2. Click the “dot dot dot” 

 

3. This will open a dialog box that will allow the user to locate the file, 

click Open to add to the File Attachment record: 

  

4. Save and Close 
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Shelter/Stays 

What is a Stay 

Stays are used to track occupancy and bed night 

statistics.  

Stays List View 

Opening a list view 

1. Select Residential Stays List from Lists in the 

Navigation menu 

 

2. A list view of all the Stays in the system will open. 

Creating a New Stay Record 

A Stay can ONLY be created from a Client Detail View see People/Client - Client/Adult Detail View -Programs/Stays for 

instruction on how to do this  

 

 

HUD Entries 
This module is used to collect HUD specific data ele-

ments for Project Entry, Project Update, Project Annual 

Assessment, Project Exit and Project Follow-up. 

Press the “New” button in the HUD entry module to 

add a new HUD Entry.  

Select the Collection Type 

 

The HUD Collection window contains a field for Notes 

related to this entry, as well as three tabs for: 

1. Person Details 

2. Health Information 

3. Income Sources, Benefits and Health 

When Saving, validation errors may occur if required field are not filled or if 

fields are not filled in properly 

A field that has not validated successfully will be highlighted with the  icon 
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Household Information/ Associated Stays 
This section can be used to associate multiple Participants to a Stay. There are three ways to link multiple participants. 

Option 1: Choose a Head of Household  

If a Participant is a Minor and their Stay was associ-

ated with an Adult/Family Member 

1. First create a stay record for the Adult 

and a then create stay record for the 

minor.  

2. On the minor’s stay record click the ap-

propriate Adult from the drop down list 

as the head of household.  

 

3. Save and Close the stay record.  

4. Save the Participant record itself 

If you open the Adult’s Stay record the minor will now be 

listed as an associated stay. Family  

member 

Option 2: Add Associated Stays 

If multiple Participants are Minors and their stay was associated with an Adult/Family member 

1. Create the Minor(s) stay record(s) 

2. Create the Adult/Family Member’s stay record 

3. Click Add and select desired Participants on 

the Adult’s Stay record 

4. Select the desired Participant(s) and click OK 

5. Select Save and Close on the Stay record 

6. Select Save on the Participant record 

The Participant(s) will now be added to the Associated Stays/Family members List for the Adult 

The Stay record associated with the minor will be updated to include the Adult as the Head of Household.  

Note: You may need to refresh the minor’s 

participant record to see the update. 

Option 3: Copy Stay to Child(ren) 

**To copy a stay to a Child, the Client must have the Child listed as a Children/Dependent** 

Add the Child as a Children/Dependent 

1. Open the Client record by double clicking on the Client from a person list view 
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2. Add the Child by clicking Add and selecting the child from the list of existing Children OR create a New Child 

record 

 

 

Add the Client as the Child(ren)’s Parent/Guardian: 

1. Open the Child record by double clicking on the Child from a person list view  

2. Select the desired Client as the Parent/Guardian.  

You can now Copy a Stay to the Child(ren)! 

There are three ways to copy a stay to the child(ren). 

Option 1: 

1. Create a New Stay record for 

the Client 

2. Enter data for the Stay record 

3. From the Stay record Click Copy Stay to Child(ren) in the ribbon 

4. Click Yes on the pop up window 

5. When you Save and Close the Stay Record, it will once again ask you “Do you want to copy this stay to the cli-

ents children.  Click No.  

If you click Yes, the following message will pop up. Select 

No. 

6. Save the Client record 

Option 2: 

1. Create a New Stay record for the Client 

2. Enter data for the Stay record 

3. From the Stay record, click Save and Close. A window will auto-

matically pop up asking if you want to copy this stay to the 

Client’s children. 

4. Click Yes 

5. Click Save and Close again  

6. Save the Client record  
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Option 3: 

If the Stay record already exists.  

1. Open the Stays List View 

2. Highlight the desired stay record from the list 

3. Select Copy Stay To Child(ren) 

 

The Child will now appear as an Associated Stay/Family Members on the Stay record. 

 

Note: If a Child’s profile is open while copying the stay, you will need to refresh the Child’s profile to view the recently 

saved Stay. 
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Services 

What is a Service 

Services is used to track any services provided to the Participant. Each service provided can be associated to one or 

many Persons, as well as one Staff Member. 

List View of Services 

1. To access the list of services, click the Naviga-

tion button and select Lists  Client Detail  

Services 

 

 

 

 

2. A full list of Services will open 

 

 

Creating a New Service 

A single service can only be created 

from a Client Detail View. 

1. Open a Client or Child profile 

2. Select the Shelter/Program/

Services Tab 

3. Click New in the upper left hand corner under 

services  

 

4. Enter the details for the service 

 

5. Save and Close 

Inputting data for a Service record 

 Full Name: Client or Child receiving the Service provided is automatically populated 
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 Staff Member: Agency Member providing 

the service, the list is populated from the 

list of staff in the system 

 Topics: Select all Topics covered during 

service  

o Click the + to expand the list 

o Hold Ctrl to select multiple items 

 

 

Creating a Group Service 

A Batch Service can only be created from the scheduler. 

1. Open the Scheduler 

 

2. There are two options to create a New Group Service 

 

Option 1.  

Click New in the Ribbon and select Service 

Select Group Service from Service drop down 

 

 

 

 

 

 

Option 2. 

Right click on the Scheduler and Select New  Service 

 

Select Group Service from Service drop down 
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Inputting Details for the Group Service 
1. Add details (date, time, program, service, etc.) for the Service. 

2. Click “Click here to add a new row” to add multiple Clients to the record.  

 

3. A drop down list will appear. To find 

a client, type their name in the Find 

box and hit enter.  

 

 

4. A list of selected clients will appear 

in the Batch Entry section. 

 

 

Removing a Client from a Group Service 
To delete a client from the Group Service 

1. Select the client and click   

2. 2. Select Yes.  

 

3. Click I Agree and click OK. 

 

 

 

 

 

On the Client Detail View, the Service will show up on all Client profiles listed.  If you edit the Service details on one client profile, 

it will edit the service details for all Clients. You must split the group service if you wish to edit the services separately. 

On the Services list view, the Service will be listed for each Client. For example, if there are two Clients associated with the group 

service, then the list view will show the service twice.  
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Splitting a Group Service 
Splitting an Activity is used to split a singular batch entry record into multiple records.  

How to Split an Activity 

IF creating a New Service 

1. Create a New Service 

2. Enter information and select Clients for Batch Entry 

3. Once multiple Clients are selected for the Batch Entry, the Split Activity button will appear in the ribbon 

4. Click Split Activity 

5. Select Yes 

 

6. Save the Case Management 

IF Service already exists in the system 

Option 1: Split Activity from Service List View 

1. Open the Service List View 

2. Select the desired Service from 

the list 

3. Select Split Activity from the  

Ribbon 

4. Select Yes when pop-up appears  

5. Save or Save and Close 

Option 2: Split Activity from Client Profile 

1. Open the Client Profile with the Service 

2. Select the desired service from the Services tab 

3. Double click on the Service to see a detailed view 

4. Select Split Activity from the Ribbon 

5. Select Yes 

6. Save or Save and Close 

***Once the Activity is split, future edits 

need to be done separately*** 

The services are no longer linked. Any edits must be completed on each client profile.  
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Victimizations 

What is a Victimization 

A Victimization is a date and time record linked to a 

Client that is used to record victimization type and 

victimization details. 

Victimization List View 

Opening the Victimization List View 

1. Select Lists > Victimization List from the Navi-

gation Menu 

2. A full list of Victimizations will open. Double 

Click on an Incident to see a Detail View 

Creating a New Victimization 

A Victimization can only be created 

from a Client Detail View 

1. Open a Client Detail View 

2. Select New in the Victimization 

tab 

3. Enter the Victimization Details 

4. Save and Close 

Selecting a Main Victimization 

A main victimization should be 

chosen on the Client profile. If 

there is only one victimization it 

will automatically default as the 

Main Victimization 

To select a Main Victimization: 

1. Open a Client Detail view 

2. Select the Victimization tab 

3. Click Main Victimization 

and select a Victimization 

from the list 
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Referrals 

What is a Referral 

A Referral is a date record used to track Referrals given by Staff to Clients.  

Referrals List View 

Opening the Referrals List View 

1. Select Lists  Client Detail  

Referrals List from the Naviga-

tion Menu 

2. A list view of all the Referrals 

will open 

 

 

 

Creating a New Referral  

A Referral can only be created from a Client Detail View 

1. Open a Client Detail View 

2. Select New in the Referrals tab 

 

3. Enter the Referrals Details 

4. Save and Close 
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Protection Orders 

What is a Protection Order 

A Protection Order is a client linked record used to 

track the status of Protection Orders.  

Protection Order List View 

Opening a Protection Order List View 

1. Click Lists > Protection Order List in the 

Navigation Menu 

 

2. A list of all Protection Orders will Open 

Creating a New Protection Order 

A New Protection Order must be made from the 

Client Detail View 

1. Open a Client Detail View 

2. Click New in the Protection Order tab 

3. Enter Details 

4. Save and Close 
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Outreach Event 

What is an Outreach Event 

An Outreach event is a Date based record for the Staff to 

track Education / Training provided out to others. Each Out-

reach event can be associated to zero, one or many Staff 

Members. However, it is not advised to have zero Staff 

Members. 

Outreach/Education List View 

Opening the Outreach/Education List View 

1. Select Outreach/Education from the Navigation 

Menu 

Creating a New Outreach Event 

Creating an Outreach Event from the 

List View 

1. Open the Outreach List View 

2. Right-Click on the list view and Select New 

 Outreach/Education 

Creating an Outreach from the Scheduler 
1. Open the Scheduler using the Navigation menu 

2. Right click on the scheduler, Select New > Outreach  

Inputting Data for the Outreach 

Audience Type: Which Audience type 

attended the Outreach/Education and 

how many of each type attended. You 

can enter multiple types. 

Select New under Outreach/Education 

Select an Audience Type from the drop down list(or cre-

ate a New drop down) and enter a Count for the number 

of attendees of that type. Click Save and Close. 

For Example: 
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Topic: Topics covered during the outreach event 

Click Add to select one or multiple topics 

 

Staff: Staff Member who attended the Outreach/

Education event 

Click Add to Select one or multiple Staff Member(s) 

 



Quick Start Guide     

 39 

 

Volunteer Time 

What is Volunteer Time 

Volunteer Time is a date and time based record for the Volunteer Staff. Each Volunteer Time can be associated with 

one or many Staff Members.   

How to create a Volunteer Time  

Creating Volunteer time from the Scheduler 

1. Open the Scheduler 

2. Right click on the scheduler, hover over New then 

click Volunteer Time 
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Hotline Call 

What is Hotline Call 

Hotline Call is used to view existing call records and create new calls 

List View of Calls 
1. Select Hotline Call from the Navigation menu 

 

2.  A List of all calls will appear on the left side of the screen.  A detailed preview of the se-

lected call is seen on the right. Double 

click on a call to open a detail view. 

 

 

 

 

 

How to Create a New Hotline Call  

Creating a Hotline Call from the Call List View  

Option 1 

1. Click New on ribbon and select Hotline Call  

2. A New Hotline Call will automatically open 

Option 2 

1. Right click on a call  

2. Select New  Hotline Call 

 

 

 

If Existing Client: 

1. Select the Client from “Existing Direct 

Service Client List” 
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Creating a Hotline Call from the Client Detail View 

1. Open a Client Detail 

View 

2. Select the Calls Tab 

3. Select New in the upper left hand corner of the Calls Tab 

Converting Call to Client 

1. Create a New Call from the Call List View 

2. Select Convert Call to Client in the ribbon 

3. Select Yes 

4. Fill in the remainder of the information regarding the Client and hit 

Enter on your keyboard or click OK 

 

5. Save the Hotline Call 

 

 

6. A new Client is now created and the current Hotline Call will be added to their Client record 
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About the Scheduler 
The Scheduler is a MS Outlook style Calendar for the software. Activities such as Community Education, Training Time 

and Volunteer Time can be seen from and created within this view. 

What’s in the Ribbon 

View 

View allows you to select the view in which you 

would like to display the information. There is a 

worksheet and scheduler view. 

Group By 

Group By is a view variant of the scheduler. 

Users can see the Scheduler in Groups by Date 

or Resource Please discover this feature yourself to see what works best for your day to day entry of information. 

Scheduler features 

The Scheduler has many options to customize the viewing experience and limit clutter as needed. 

Staff View 

A list of staff can be seen in the top right hand 

corner of the scheduler. Each staff has a check 

box “Show In Scheduler”.  By simply clicking the 

check box it will make that Staff Member will be 

visible in the list of Resources in the Scheduler.  

Unchecking Staff Member will remove them from 

the Scheduler. Each Staff Member has the ability 

to be temporarily hidden on the Scheduler; this 

allows quick viewing of one or two Staff 

Members. 

Time Increments 

The Scheduler can display Activities by 

various time increments. 

Increments Area (highlighted in red) 

Accessing the Increments 

1. Right click on the Increments 

Area 
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2. Select an appropriate increment 

 

3. The current increment will be displayed with a check mark to the left of the  

increment 

Alternate Views 

1. Right click on the Increments Area 

2. Hover over Change View To >  

3. Select a view 

 

 

 

 

Monthly view can be seen below 

 

Copy and Pasting Events within the Scheduler 

Events such as volunteer time, group service, etc. can 

be copied and pasted within the scheduler if they occur 

more than once. 

1. Create an Event (Ex. Staff Development) 

2. Click on the event in the scheduler 
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3. Hit CTRL + C on your keyboard 

4. Click the desired time frame for the new event 

( it will be highlighted with blue) 

 

5. Hit CTRL + V on your keyboard 

6. The event will be created for the highlighted 

time frame 

 

Editing Events from the Scheduler 

Extending and Shortening an Event from the Scheduler 
1. Hover over the edge of the event, until the dou-

ble arrow appears 

2. Drag the Event to make the Event shorter or 

longer 

 

Moving an Event in the Scheduler 
1. Left click and hold the Event 

2. Drag and drop the event in the desired time frame 



Quick Start Guide     

 45 

 

Shortcuts 

Here are a few tips, tricks and shortcuts to navigate the software. 

Entering Data 

When entering data like a Client profile, many users need to switch from the keyboard to the mouse over and over 

again.  Here are a few keyboard shortcuts that will limit the use of the mice. 

Tab 

Clicking the Tab button will move the focus of 

the cursor from one field to the next 

1. Cursor is on the field Last Name 

 

2. Clicking the Tab button on the key-

board will move the cursor the First 

Name (next field in the list) and highlight the text 

Additional note, holding the Shift button and clicking Tab will bring the cursor to the previous field.   

Tabbing between Tab 
CTRL + Tab will move between the software tabs. 

Navigating a List 

1. Gain focus of the Tab  

2. Use the Up and Down Arrows to gain focus of the record to be access/opened 

 

 

3. Click Enter to open the highlighted record 

More Info fields/items 

When entering data for a “more info” fields like Phone Numbers or Address, there is a “dot dot dot” button 

The user can move the mouse to the button and click; however, clicking the Space bar will achieve the same function: 

1. Gain focus of the Address field 

2. Press the Space Bar 

3. Returning back to the previous screen by hitting Enter, or by clicking the Ok button. 

Drop Downs 

Selecting a value from a drop down doesn’t require the use of a mouse. 

1. Gain focus of the drop down (sometimes 

referred as a Lookup) 
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2. To select a value there are two options: 

a. Click the Space bar to open the drop 

down 

 

 

b. Type the first few letters of the value 

you are looking for 

 

3. Navigate through the list of drop downs using 

the up and down arrows on your keyboard. 

Clicking Enter will select the value.  

 

Additional note: clicking ESC while the drop down list is open will cancel the current select and revert to the value be-

fore this process.  If the value was blank before this process the ESC button will leave it blank. 

Drop downs and Searching 
A drop down can have many options, when 25 or more, the drop down will default to a Search (unless modified 

through the advanced Model File Editor), navigating the Search can be achieved by only using the keyboard 

1. Gain focus of the drop down and open by either 

typing for search or clicking the Space bar 

 

2. The cursor will be defaulted to Find. The user has 

two options: 

a. Click Enter to see values  

b. Type or modify the value of the text 

you wish to find, then click Enter 

 

 

c. If more than 1 option is available, the user can use 

the Up and Down Arrow keys to select the desired 

value 

3. To go back to the Find, Shift + Tab will focus the cursor on 

the Find text 
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Setup Agency-Shelter information 

Accessing Program Options 

Please login as an Administrator (Primary User) to access and modify Program Options 

To open the Program Options (or Show Options) 

1. Click on the Tools tab 

2. Click Show Options 

 

3. On the Program Options 

tab, enter any of the required information, click Ok when ready to Save 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Setup Shelter Beds/Max Stays 

1. Locate Max Stays field and enter the numeric value of the Maximum amount of beds that the Shelter can sup-

port (ie: 50 beds = 50, 100 rooms with 150 beds = 150 beds), click OK when setup 

 

 

2. This will update your Shelter 

Stats 

Click on the Home tab 
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Click on Shelter Stats 

 

Max Stays is now showing 50 because the Pro-

gram Options were updated: 

 

Exceeded Stay Limit Message 

Software License has exceeded the limit of Stays 

Typical Error Message when there are too many Stays:  

 

This message means that there are too many Stays (with no 

Discharge Date), exceeding the Max Stays in Program Options. 

Creating Staff/Users to login to WS 

Navigating to Staff List View 

1. Open the Navigation Menu 

2. Select Users > Staff List 

 

 

 

3. A list of all of your Staff members will open 

 

Creating a New Staff Member 

1. Click New > Staff in the Ribbon 
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3. Input First Name, Last Name, User Name (please note that User Name MUST be unique) 

4. Select Appropriate check boxes 

Is Active: The Staff member is a current Staff member 

Show in scheduler: The Staff member’s activities will show in the 

scheduler 

Volunteer: The Staff member is a volunteer 

Allow Edit own Schedule only: The Staff member can edit only their 

own schedule 

Account Locked: The Staff member is unable to login 

Change Password on First Logon: The Staff member will have to change their password when they first login  

5. Choose Role(s) by Clicking Add in the Roles tab 

 

 

6. select desired role(s) and click OK 

 

7. Click Save. 

 

8. Now that the new Staff  is Saved with a Username and at least one 

Role, a Password must be generated for the Staff member to login 

for the first time, click Reset Password 

 

 

9. Either record the predefined password OR clear the existing pass-

word and enter a desired password. Click Reset Password.   
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10. Now that the Reset Password has been performed, the software will automatically check Change Password On 

First Login. Save and Close to complete the new Staff Member. 

If this new Staff does not want to change their password on first login (or the Administrator would like to keep 

a record of each password) then uncheck Change Password On First Login allowing the Staff to simply login. 

Note:  This created a Staff member with the default Model File (customization look and feel). Please see how to Pull or 

Push Model File if the first login of this Staff DOES NOT look like the Administrator Model File. 

Creating a New Staff Role 

1. From the Navigation menu select Staff > Staff Role 

 

2. In the Ribbon select New > Staff Role 

 

 

 

 

 

3. Name the Role 

4. Select the appropriate check boxes 

 

5. Select the desired Permissions 

 

 

6. Save and Close 

 

 

Filtering in a List View 
Within the software, there are many ways to 

filter information on List View (grid of infor-

mation).  These types of filtering will allow the user to quickly filter the information as the fly or setup permanent filters 

that can be applied as needed.  Please review the various ways of filter to determine the best solution for various situa-

tions. 



Quick Start Guide     

 51 

 

Full Text Search (Ribbon) 

The Full Text Search is 

available in the Ribbon 

on List Views. 

The Full Text Search will search the main fields on that Object, it will not search major module or tab related infor-

mation. 

For example, if searching the Client List for “female”, this will return Clients that have the word “female” in the Gender 

section on their main profile of information. The search will produce results even if the information is not displayed on 

the screen (either List View or Detail View)  

Searching 

Full Text Search is a simple text box, enter the word, words or phrase, click Search or hit the [Enter] button on 

the keyboard. 

Removing/Clearing search 

When a search has already been applied, removing or clearing the search can be accomplished by clicking the X 

next to the searched word, or by deleting the text in the text box and hitting the [Enter] button on the key-

board. 

Filtering  

Filtering from 

the drop down 

is one of the more advanced areas for filtering.  In this area, users are able to create New and Edit existing filters.   

 

Filtering Drop Downs are quite powerful and useful, if used properly.  If a user was to 

apply a filter, then close the software, the next time the user logs in the filter will still 

be applied.  Remember to set the Filter back to All Items to see a full list of items.  

Applying an existing Filter 

1. Click the arrow near the right side of the drop down  

2. Scroll (if necessary) to find your desired  filter, then click on the selection 

3. With the Filter applied, the List View shows only items with the desired Filter. 

Remove applied Filter 

1. Locate the filtering drop down 

2. Select All Items 

Creating a New Filter 

1. Click the Filter drop down arrow 

2. Select New… 

3. Name the Filter, enter the proper conditions, 

click Save and Close 
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Find Panel 

The Find Panel is a simple tool that only searches columns that are visible on the List View 

 

 

 

 

 

Showing the Find Panel 

1. Right click on a Column Heading 

2. Select Show Find Panel 

 

 

 

 

 

Searching the Find Panel 

To search with the Find Panel, enter the de-

sire text into the text box. 

In the example we are searching for “Female” 

Removing/Clearing the Find Panel Text 

Removing or clearing the text on the Find Panel can be accomplished two ways 

1. Click the Clear button on the Find 

Panel, this will remove the text and 

clear the search 

2. Delete the existing text and press Enter on the keyboard 

Searching with the history in the Find Panel 

Each search performed with 

the Find Panel will added to a 

temporary history list that is 

cleared when the tab is closed 

To access the history, click on 

the drop down arrow to the right of the Text Box and select an entry from the search history list 
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Quick Auto Filtering 

This technique can be used to quick-

ly filter out a specific column of data, 

much like the Auto Filter Row.  

Note: more than 1 column can be 

filtered, simply repeat the steps be-

low. 

1. Hover the mouse over a Column Heading 

2. Within the Column Heading, click the  

(filter icon) 

3. The filtering options will now appear in a 

drop down like control 

4. Select one of the options to only see the 

selected option  

 

 

Note, at the bottom of the List View, there is now a Filtering Summary that can be used to enable or disable 

the applied filter in this example 

 

 

Filtering Summary 
The Filtering Summary is a control 

panel for Auto Filtering Row and 

Quick Auto Filtering, but it does not 

have any relation with the Filtering 

(Drop Down in Ribbon) in the Rib-

bon.  Please be aware that the user 

may need to remove a Filtering (Drop 

Down in Ribbon) in order to use Auto 

Filtering Row and/or Quick Auto Fil-

tering and vice-versa 

Filtering Summary can be found at 

the bottom of the screen. 
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Remove/Delete filtering 

 

Temporarily Enable or Disable filtering string 

 

Current Filter (enabled or disabled) 

 

Access Filter history list 

 
Filter history list (from arrow in example above) 

 

Advanced Edit Filter 
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Initial Value on a Field 
What is an Initial Value 
An Initial Value is data that will be automatically entered when creating a new entry  

For Example: An Initial Value for Gender could be set to Unknown. The new Client’s Gender would automatically be 

Female. If Female is incorrect, then the user would simply change the Gender. 

Set Initial Value 
Note: Only Staff with Agency Administrators roles can set Initial Values 

1. Open the Detail View where the Initial Value is requested  

2. Locate the field on the Detail View  

3. Click the field until the field is highlighted 

4. Select the value desired for the Initial Field  

5. Right Click on the field then select Set As Initial Value 

 

6. Close the Detail View (Save as needed), create a new record to 

confirm Set As Initial Value 

Note: Initial Value can be set on the following types of Fields: Text Box, Long Text Box, Drop Down, Number, Number 

with Decimals and Dates. 

Clear Initial Value 
1. Open the Detail View that the Initial Value is applied  

2. Locate the field on the Detail View  

3. Click the field until the field is highlighted 

4. Right click on the field and Select Clear Initial Value 
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Required Fields 

What is a Required Field 

A Required Field is a Rule that can setup on specific Detail Views so that Staff is informed on Save if one or many fields 

that are missing values. 

Reporting is the number one reason to have Required Fields setup, this will allow a more accurate reporting period be-

cause some field (ie: Gender) default to blank/empty, but many Staff require this data even if it is not known (ie: Un-

known). 

Make a Required Field 
Note: Only Staff with Agency Administrators roles can set Required Fields 

1. Open the Detail View that the Required Field is to be setup  

2. Locate the field on the Detail View  

3. Right Click on the field then select Make Field Required 

4. A Required Field Options box will appear.  Enter a Custom De-

scription that will appear when a user attempts to save their 

work without filling in the required field. Choose the result type 

from the drop down  

a. Error: Cannot save without entering a value 

b. Warning: Can Save without entering a value but the us-

er is prompted  

c. Information: The user will see an information icon next 

to the required field if they save without closing the 

window 

5. Now that the field is Required, the field will show a Red border around the field. This is used to visually indicate 

that this is Required 

 
6. If the required field is empty, the system will now prompt users that the field is required depending on 

which level of requirement you chose (ie. Error, Warning, Information) 

Clear Required Field 

1. Open the Detail View that the Required Field is to be setup  

2. Locate the field on the Detail View (ie: First Name) 

a. If the field is NOT visible on the Detail View the Staff 

member will need to customize the Detail View to have 

the field, close the Detail View and reopen. Right clicking 

on the newly added field will not work until reopening of 

Detail View. 

3. Right Click on the field then select Clear Field Required 
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Modifying/Adding drop down options  

Drop Down values can only be added to a limited number of drop 

downs in the system.  

Adding a New Drop Down Value 
1. Select the arrow next to the desired drop down and Click 

New 

 

 

 

 

 

2. Enter Name for New drop down 

 

 

 

3. Save and Close 

Deleting a Drop Down Value 
1. Select the desired drop down that you wish to delete  

 

2. Right Click on the field and select Open Item 

 

3. Click Delete 

4. Click Yes 

 

 

 

 

5. Select I Agree and Click OK 

 

6. Save the entire Record to update the changes.  
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Column Chooser 

The Column Chooser allows you to choose which columns you would like in a table in a list view. 

Adding Columns to a List View 
1. Right Click on a header in a list view and select 

Column Chooser 

 

 

 

2. This will make the Customization window visible 

for the List View 

  

 

 

3. Select Add  

The Add button is where you can access the Object 

Model; to add fields into the Fields ready to be added 

to Form. 

4. Click the + to see a full list of options 

 

5. Select the desired value and select Add 

 

 

6. Select the desired value with your mouse and hold the mouse down while you drag the value to the correct 

spot in the column header. Release the mouse to drop the value into the header. The two arrows on the List 

View Columns will show where the field will be placed when the mouse button is released.  

Alternatively, double click the 

value and it will be automatically 

added to the end of the list. 
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7. The value will now be present as a column 

 

 

 

8. Click the X to exit the Customization Window. Your changes will be saved auto-

matically. 

 

Repeat the above steps until all the desired fields are customized 

onto the List View.   

 

Hiding Columns from a List View 
There are two options to remove a column from a List View 

Option 1 

1. Right click on the Column Heading 

2. Select Hide This Column 

The Customization window does not need to be visible/

enabled for this task 

Option 2 

1. Right click on the Column Heading 

2. Select Column Chooser 

 

 

3. Click and hold the column you wish to remove, drag it to the Customization win-

dow 

 

 

4. Click X to exit the Customization Window. Your changes will be saved automatical- ly. 
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Quick Tips when customizing 

 
1. Never customize a List View (ie: Person Activity) when you have 2 or more of the same List Views open.  This 

may cause an issue when you close out of the software and log back in because the software will select the 

other List View as the customization, thus losing the work the Staff member attempted to complete. 

 

2. Never customize when the Staff member is logged in on another Workstation (two logins in use of the same 

username), this may cause and issue when you close the software (as well as the other workstation), the soft-

ware will select one of the two to save, thus losing the work the Staff member(s) attempted to complete. 
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Sorting a List View by various fields 
List Views can be sorted by not only 1 field but as many as needed.  By default, most List Views will not be sorted; this 

can be determined by looking for an arrow in each Column in the List View 

Sorting views 

No Sorting 

 

First Name Sorted Ascending (A-Z) 

 

Last Name Sorted Descending (Z-A) 
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Clear All Existing Soring 

To Clear Sorting for all Columns, 

right click on a Column and se-

lect Clear Sorting 

 

 

Sort by one Field 

To sort by one field (and remove all previous sorting), locate and click on an existing Column Heading Click one time to 

sort Ascending (A-Z); click a second time on the same column heading to reverse the sort order to Descending (Z-A). 

Sort by one or More Fields 

1. Right click on an existing Column 

Heading  

2. Select Sort Ascending or Sort De-

scending 

 

3. Repeat on another Column 

Heading to further sort. 
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Group by Box 
Grouping is a feature in the software where the user can group common infor-

mation, allowing an enhanced visual understanding of the information 

To sort a Grouping, the Group By Box must be visible 

1. Right click on a Column Heading 

2. Select Show Group By Box,  

 

 

3. Now that the Group By Box is visible, drag and drop the heading col-

umn into the group by box area 

 

4. Drag and drop various headers as 

needed.  The Group by Box area 

will show a waterfall type display 

of groupings that are applied 

 

 

5. Right click on the Group By Box area and 

select Hide Group By Box.  It is recom-

mend to close the Group By Box once 

Sorting is complete 

 

6. The list view will now show the desired grouping 
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Ungroup specific field 

1. Show Group By Box 

2. Right click on a grouping field and Select UnGroup 

 

 

 

 

Clear Grouping(s) 

1. Right click inside the Group by Box area and click Clear Grouping 

2. Right click inside the Group by Box area and click Hide Group by box to exit grouping 
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Backup a SQL Database to a file 
1. Open Start Menu > Microsoft SQL Server 2008 R2 > SQL Serv-

er Management Studio 

2. Connect to the appropriate instance of the Microsoft SQL 

Server Database Engine, in Object Explorer; click the server 

name to expand the server tree. 

3. Connect to the Server 

Note: You may need to select Authentication: SQL Server 

Authentication and then Enter your username and password 

(This was created when you installed SQL Server. It may 

be User name: SA and password: osniumws) 

4. Expand Databases 

5. Right Click on the database to backup, Tasks > Back Up… 

 

 

 

 

 

6. Remove any existing backups path (as they are not need-

ed or would “double” backup if using the same one over 

and over) 

 (before) 

 (after) 

 

 

 

7. Select the Disk option and then Click Add (to create a da-

tabase *.bak file in a specific location) 
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8. Selecting a Backup Destination, click the … at the end of File Name, then provide the file name of the backup 

that is being created.  

Osnium would suggest to prefix the software name (ie: 

WS) then an underscore (ie: _) followed by a standard date 

format (ie: 20150107), and lastly .bak  

Example File Name: WS_20160107.bak 

 

 

 

Note, default backup folder depends on the version of Windows and SQL Server, however a typical folder path 

is as follows:  
C:\Program Files\Microsoft SQL Server\MSSQL10_50.SQLEXPRESS\MSSQL\Backup 

 

9. Final step is to verify or transfer the file to another media type other than the Server’s hard drive.  Osnium 

would suggest copying the *.bak file to another PC or USB Key with sufficient space in case of any major disas-

ter at the location of the server.   

 

Note, keep in mind that the database backup may contain confidential information and should not be shared 

over the internet without secure password or transfer of the file. 

Restoring a database file to SQL Server 
1. Close all connections to the database about to be restored 

2. Open Start Menu > Microsoft SQL Server 2008 R2 > SQL Server Man-

agement Studio 

3. Connect to the appropriate instance of the Microsoft SQL Server Data-

base Engine, in Object Explorer; click the server name to expand the 

server tree. 

 

4. Connect to the Server 

Note: You may need to select Authentication: SQL Server Authentication and the Enter your username and 

password (This was created when you installed SQL Server.  It may be User name: SA and password: osni-

umws) 

5. Expand Databases 
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6. Right-click the database (if already exists), Tasks 

> Restore > Database… 

 

 

 

 

 

 

 

 

7. On the General page, select From device: Click 

the browse button (ie …) 

 

 

 

 

 

 

 

 

 

8. Now the Specify Backup dialog box is visible. Click Add 
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9. After you add the downloaded database to the list (extract if need-

ed), click OK to return to the General page 

 

 

After selecting screen should look similar to below screen shot, if 

so, click Ok: 

 

10. In the Select the backup sets to restore grid, select the backups to 

restore by the check box beside it (this should only be one). This 

grid displays the backups available for the specified location. 

 

 

11. Click Options in the Select a page pane 

 

12. In the Restore options panel, you can choose any of the 

following options, if appropriate (for your situation and 

most other situations): Check Overwrite the existing da-

tabase 
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13. Once Ok is clicked the Restore of the database will begin (ie: 0 to 100%) 

 
 

14. Successful Restore of a database 

 
 

15. Test for successful login to software to complete, using the Administrator login. 
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Running Reports 

Types of Reports 

Display Reports 
Display Reports display data related to various object records in the database and are useful for printing out Client/

Child/Abuser details. Each of the Client/Child/Abuser tabs can be printed using the display report. 

Generic Reports 
Generic Reports display data related to various administrative tasks, as well as data not 

directly associated with a specific database object. For example, the Service Report can 

gather all the details of the Services during a given date range, then it can be filtered 

by the various parameters in the report.   

Funder Reports 
Funder Reports display data in a format similar to the state or federal Funder reports.  

Importing a Report 

1. Navigate to the reports section by click on the navigation button > Reports 

 

2. Then click on the "Import / Export Reports" button and select the "Import Re-

port" option. 

  

 

 

 

3. Locate the reports that you wish to import and select them. If you're importing one report, you can click on it 

then hit the "Open" button. If you're importing multiple reports, you can press and hold the left mouse button 

to select multiple reports, then hit the "Open" button. 

Please Note: only *.repx files can be imported 

When the reports have been imported, you will see a verification window. 
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Generating/Running a Report 

To generate a report, double click on the desired report OR right-click on the report that you wish to run, and click exe-

cute report. 

 

 

Filtering Reports 

Use the drop-downs to select a start and end date for the report. 

Use the drop-downs to adjust the filters in the Parameters section to highlight the information desired. The filters avail-

able will vary depending on the type of report being accessed. 

Click Submit to run the report with the selected filters. 

Click Reset to clear the applied filters. 

After running the report, icons in the ribbon will be active. Options include saving the report, printing, adjusting the 

report view, exporting to a different file format, emailing the report and closing the report.  

Exporting Reports 

To Export the report to a different file format, select the and choose the format to export 
the report to (PDF, HTML, MHT, RTF, XLS, XLSX, CSV, Text, Image).  

Select OK on the Export Options window. 

Give the report a name and choose a file location.  

Click Save. 
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Using the Email Report Function  

After running a report, click the email icon . This will take you through the steps of saving the report as a PDF. 

After naming the report and choosing a file location, click Save.  

This will open Microsoft Outlook with the report attached to an outgoing email.  

Adding a Watermark 
Including a watermark is a useful way to indicate the status of a report (ie. draft, final) or instructions on use, confiden-
tiality and ownership.  

To add a watermark after running a report, click 

the watermark icon to open the Water-
mark options window. 

For a text watermark: complete the form choos-
ing the text, direction, transparency, font, color, 
size position and page location.  

For an image watermark: click on the Picture Watermark 
tab in the Watermark options window. Click browse to 
find and select the image. Adjust size, alignment, trans-
parency, position and page range. 

The image on the left will preview the water-
mark with the selected options. 

Click OK to apply the watermark to the report. 

Thumbnails 

Click the Thumbnails icon to show thumbnails of pages in the report. 

Saving Reports 

Click on the Save icon to save the report. Users will be promoted to choose a location to save the file. 

Printing Reports 

Click the printer icon  to print the report directly from os-soft. 

Page Setup 

Click the Page Setup icon  to access options for adjusting the report’s layout (paper size, orientation, mar-
gins).  


